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Greetings

Thank you for your interest in participating in CHI2004 Design Expo! This document will help you prepare your submission. Submissions are due by 12 January, 2004, 5 PM Pacific Standard Time.
Using this two-part document

The first five pages of this document contain formatting and submission instructions. Starting on the sixth page, you will find the submission template with guidelines for content and layout. PLEASE USE THIS AS YOUR FORMATTING GUIDE. We recommend that you:

1. Save a copy of this document.

2. Delete the first five pages (these instructions).

3. Replace the appropriate text (e.g., the text under each heading) with the contents of your submission. Note that a Design Case is limited to 16 pages, inclusive of all illustrations.
Keywords

On the first page of your submission, we request a list of keywords to assist in indexing. An incomplete list of possibilities are: Animation, Anthropology, Benefit Analysis, Branding, Business Case, Business Strategy, Cognitive Psychology, Concept Design, Content Strategy & Creation, Design Planning, Ethnography / Ethnographic Studies, Experience Design, Experience Strategy, Graphic Design, Industrial Design, Information Architecture, Interaction Design, Marketing / Market Research, Multi-channel Applications, Multidisciplinary Design / Interdisciplinary Design, Organizational Culture, Organizational Planning, Participatory Design, Performance Metrics, Process Improvement, Product Design, Product Management, Service Design, System Design, Usability Research, User Experience, User Interface Design, User Research, User-Centered Design / Human-Centered Design, Visual Design, Visual Systems. 

If you need a different keyword than those listed above, please contact the design expo chairs at chi2004-design-expo@acm.org. Establishing new keywords is an important part of indexing your work for efficient retrieval from the ACM Digital Library.
Text formatting

Please use 8.5-point Verdana font, or other sans serifs font as close as possible in appearance to Verdana in which these guidelines have been set. (The “Normal” style for this document automatically gives you this font setting.) Arial 9-point font is a reasonable substitute for Verdana as it has a similar x-height. Please use serif or non-proportional fonts only for special purposes, such as distinguishing source code text. 

Text styles 

The template uses MS Word text styles to facilitate text formatting. The applicable text styles are:

· normal – for body text

· heading 1, heading 2, heading 3

· bullet list

· numbered list

· caption

· annotation – for notes in the narrow left margin

· reference – for bibliographic entries

Additionally, here is an example of footnoted text.
 (the footnote is created with the “footnote…” command under the “Insert” menu in MS Word).  As stated in the footnote, footnotes should rarely be used.

Reference and citations guidelines

Use the standard Communications of the ACM format for references — that is, a numbered list at the end of the article, ordered alphabetically by first author, and referenced by numbers in brackets [1]. See the examples of citations that follow this section. 

References should be published materials accessible to the public. Internal technical reports may be cited only if they are easily accessible (i.e. you can give the address to obtain the report within your citation) and may be obtained by any reader. Proprietary information may not be cited. Private communications should be acknowledged in the body of your content, nor referenced as a citation at the end (e.g., “[Robertson, personal communication]”). Why are references and citations important? Because your accepted case study represents an addition to the body of literature in this field. Acknowledging precedents and situating your work in the context of preceding work illustrates your awareness of developments, issues, and controversies on the topic of your case study that may help the reader further explore your perspective and the perspectives of other authors whose work influenced you. It is also a convenient way to represent your agreement or disagreement with a body of work without including a lengthy discourse in your case study. Citations are checked by reviewers for accuracy and appropriateness, so please limit your citations to available works.

Example citations

[1] Anderson, R.I., Crakow, J., and Joichi, J. Improving the design of business and interactive system concepts in a digital business consultancy. Proceedings of DIS 2002 (London, June 2002), ACM, 213-223.

[2] Association for Computing Machinery SIG PROCEEDINGS template. www.acm.org/sigs/pubs/proceed/template.html.

[3] Mok, C. Designing Business: Multiple Media, Multiple Disciplines. San Jose, CA: Adobe Press, 1996.

[4] Norman, D. A. Emotion and design; Attractive things work better. interactions, 9(4), July-August 2002, 36-42.

Language, style, and content

The written and spoken language of CHI2004 is English. Spelling and punctuation may consistently use any dialect of English (e.g., British, Canadian, or US). Hyphenation is optional. 

Please write for an international audience:

· Write in a straightforward style. Use simple sentence structure. Try to avoid long sentences and complex sentence structures. Use semicolons carefully.

· Use common and basic vocabulary (e.g., use the word “unusual” rather than the word “arcane”).

· Briefly define or explain all technical terms. The terminology common to your practice/discipline may be different in other design practices/disciplines.

· Spell out all acronyms the first time they are used in your text. For example, “World Wide Web (WWW)”.

· Explain local references (e.g., not everyone knows all city names in a particular country).

· Explain “insider” comments. Ensure that your whole audience understands any reference whose meaning you do not describe (e.g., do not assume that everyone has used a Macintosh or a particular application).

· Explain colloquial language and puns. Understanding phrases like “red herring” requires a cultural knowledge of English. Humor and irony are difficult to translate.

· Use unambiguous forms for culturally localized concepts, such as times, dates, currencies and numbers (e.g., “1-5-97” or “5/1/97” may mean 5 January or 1 May, and “seven o'clock” may mean 7:00 am or 19:00).

· Be careful with the use of gender-specific pronouns (he, she) and other gender-specific words (chairman, manpower, man-months). Use inclusive language (e.g., she or he, they, chair, staff, staff-hours, person-years) that is gender-neutral. If necessary, you may be able to use “he” and “she” in alternating sentences, so that the two genders occur equally often. 

Figures

The examples on this and following pages should help you get a feel for how screen-shots and other figures should be placed in the template. Be sure to make images large enough so the important details are legible and clear.
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figure 1. Insert a caption below each figure. Use the “caption” style to format the text. This image does not convey details, but does show basic page structure.

If you aren’t familiar with MS Word’s handling of pictures, we offer one tip: the “format picture” dialog is the key to controlling position of pictures and the flow of text around them. You access these controls by selecting your picture, then choosing “Picture…” from the “Format” menu. 

The picture format dialog has five tabs, with three—size, position, and wrapping—probably being the most useful here. 

As for the “picture” tab in that dialog, we recommend using Photoshop or other graphics software to scale images, rather than scaling them after you have placed them in MS Word. MS Word’s scaling tends to reduce the clarity and legibility of images more so than dedicated graphics software.

[image: image4..pict]figure 2: If your figure has a light background, you can set its outline to light gray, like this, to make a box around it. The column width is 3.34”, so setting this picture to fill the column was easily done by right-clicking on it (option-click on the Mac), choosing “format picture,” then the “size” tab, and setting its width to 3.34 inches. 

The next page shows a treatment of large figures, too big to fit inside a single column of text. 
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Figure 3. You can make figures as wide as you need, up to a maximum of the full width of both columns. To achieve this, select the figure and the caption, choose “columns” under the   “Format” menu, pick the “One” (single column) icon at the top of the dialog, and make sure you are making the change only for “selected text” (at the bottom of the dialog). This image was saved as a TIFF which produces reasonable quality, so readers can clearly see the details. 

Packaging your submission

Prepare your submission as an Adobe Acrobat (4.0 compatible) PDF file with embedded fonts and graphics. For instructions on how to make a PDF, see Guide to PDF Files. Please limit your submission to a final archive data size of 10MB. 

How to Submit

4. Please title your submission file (case sensitive): CHI04DE_leadauthorlastname.pdf

5. Then, ZIP or STUFF your PDF into an archive titled (case sensitive!): CHI04DE_leadauthorlastname.zip or CHI04DE_leadauthorlastname.sit.

6. Then, by 12 January, 2004, 5 PM Pacific Standard time, send your PDF file to chi2004-design-expo@acm.org.
If you have any difficulties with any part of this process, please send email to chi2004-design-expo@acm.org.

After you submit

We will send you a confirmation of receipt of your submission within one week.  If you have not heard from us, please contact chi2004-design-expo@acm.org.

You will be contacted if we have any technical difficulties with your submission.

Questions

Send email to the Program Chairs at chi2004-design-expo@acm.org if any questions arise.
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Title of submission: The title of the document goes here

Category of submission: Design Case Study

Name and full contact address (surface, fax, email) of the individual responsible for submitting and receiving inquiries about the submission: Contact Author, 123 Author Ave., Authortown, PA 54321, USA, +1 111.555.1212, authorx@anotherco.com

(Remember that a Design Case Study is limited to 16 pages, inclusive of all illustrations.  Please delete these words from your cover page. The cover page does NOT count toward the 16-page limit.) 

Permission to make digital or hard copies of all or part of this work for personal or classroom use is granted without fee provided that copies are not made or distributed for profit or commercial advantage and that copies bear this notice and the full citation on the first page. To copy otherwise, or republish, to post on servers or to redistribute to lists, requires prior specific permission and/or a fee. Copyright 2003, ACM.
The Title of the Document Goes Here



Abstract

Please limit your abstract to 150 words. This abstract will be displayed in the ACM Digital Library and the AIGA Experience Design Case Study Archive. Just to give you a feel for what you can do in 150 words, this little description will ramble on for the full allotment. 

Please use the word count command in MS Word to help you to adjust your abstract text. This will also help sharpen your text to present your ideas more precisely. Keep in mind many readers will look at the Abstract to judge if they want to read your paper or not.

Your abstract should summarize the key findings so the people who should be reading your paper are drawn to it, and other people won’t be disappointed—any misunderstanding created by an alternate reading of, for example, the title, is cleared up by your abstract. This example is exactly 150 words.

Keywords

These keywords identify search terms for your case study, which will make it easy to find within the ACM Digital Library. List them here, separated by commas. 

Industry/category

We are looking for design solutions, practice, and research in all industries. Use as many descriptors as it takes to be specific. (e.g., financial services, banking, education, entertainment, healthcare, etc.) 

Project/problem statement

Place your project statement here. This is a summary description of the project’s goals—the people, context, and activities it sought to address, business, market and technology goals, the goals of the project’s sponsors or stakeholders, and so on. Be sure to include industry, problem, and goals (business, market, users, technology), etc.

Background/Project participants

Please identify all the project's participants and their roles. Including:

· Names of Team members, and their roles

· Brief background descriptions

· History and context

Project dates and duration

When did the project begin? How long did it last? You can include additional information about the amount of effort and resources expended.

Challenge

In real-world design pursuits, there is often a curveball, which makes it impossible to follow ideal-path processes. Was there something in this project, be it a budgetary or time limitation, a technological constraint, a political challenge, a midstream change in priorities, etc., that would affect how the project was executed?

Solution summary

Tell the story of the project. An abstract or summary description of the process including:

· Methods, tools, procedures, influences

· What did you choose to do and why was this the most effective solution? In retrospect, were these choices effective?

· What other best practices were considered but not used? Why were they not pursued?

Solution details

· How did the design solution support project requirements?

· How were end-constituents (end-users, business/organizational and other stakeholders) involved in process?

· What were the elements of the design strategy?

· Describe what is unique or convention setting about the user experience(s)?

· What were the constraints of the solution?

· How was business & culture affected as a result?

· What was the feedback -- the user response?

· What was the impact on you and/or the end users?

Results

Results measured against the stated project goals/problems, including:

· How did you measure success?

· What insights were gained?

· What is repeatable, and what would you do differently?

· What are the next steps in the work, anticipated growth and development of the study's concepts? 

Please use throughout sufficient illustrations of the solution (e.g., screenshots, storyboards and other illustrative images of design solutions) to communicate your ideas sufficiently.
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[5] Put your references here according to the instructions in the guidelines, using the “references” text style.













You can use this narrow column on the left for an annotation, supplementary figure, callout,… anything that supplements the material on the page. By putting it here, you can call attention to it without breaking the flow of the main text.  





This is what MS Word calls a “Text Box.” Make one by choosing “Text Box” from the “Insert” menu, then dragging the cursor to about the right size and shape. 





To set the proper size and position, right-click on the border of the box it (option-click on the Mac), choose “Format text box…”, and set the following properties:


size: width = 2 inches


position: horizontal = .5” from page.


colors and lines: line = no line





One good use of the narrow margin column: callouts that annotate a figure, either with text or a more detailed image.  





Tip: This template uses Word’s (sometimes frustrating) multi-column layout capabilities. If you want to force text to start on a new column, use the “Break…” command under the “Insert” menu to insert a “column break.” Watch for section breaks carefully – they must be paired to exit and return to the double column format. 
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�	Use footnotes sparingly, if at all. Footnotes are preferred over end notes.





